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EXPERIMENT NO. 01    

 

FAMILARISATION WITH MAT- LAB- CONTROL SYSTEM TOOL BOX, MATLAB - 

SIMULINK TOOL BOX & PSPICE. 

 

Objectives:  

 Using 'MATLAB base program + Control System toolbox', for control systems analysis 

and design. 

 Building simple Simulink simulations.  

 Running Simulink simulation to predict a system's behaviour. 

 Transient analysis using PSPICE 

 

MATLAB, an abbreviation of MATrix LABoratory, is a high-level technical computing 

environment suitable for solving scientific and engineering problems. The MATLAB family of 

programs includes the base program plus a variety of application-specific solutions called 

toolboxes . Toolboxes are comprehensive collections of MATLAB functions that extend the 

MATLAB environment to solve particular classes of problems. 

The MATLAB base program along with the functions from the Control System Toolbox, can be 

used to analyze and design control systems problems. Control System Toolbox includes interactive 

analysis and design tools called LTI Viewer, and SISO Design Tool. The LTI Viewer uses a 

Graphical User Interface (GUI) to generate and view time and frequency response plots of Linear 

Time-Invariant (LTI) transfer functions and obtain measurements from these plots. The SISO 

Design Tool uses a GUI to provide a convenient and interactive way to design Single-Input-Single-

Output (SISO) control systems by the conventional trial-and-error approach. 

 

ASSIGNMENT - 1 

 

MATLAB basics 

 
1. Open MATLAB command window. Observe the commands poly, polyval, roots, diff, int, 

deval, solve, dsolve, laplace, ilaplace, residue, tf, series, parallel, feedback, plot, zp2tf, 

tf2zp 

 

2. Write a MATLAB program to find the roots of the polynomial 

2s
5
 + 4s

4
 + 3s

3
 +5s

2
 + 11 = 0 

 

3. Find the general solution of the following quadratic equation. 

a)                

b)                                            
 

4. Find the general solution of the following differential equation. 

                       ( )      ( )     
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5.   Consider the two matrices   [          ]           [           ] 
Write a MATLAB program to determine 

 A+B 

 B
-1

 

 A
T
B

T
 

 

6.   Write a MATLAB program to generate an overlay plot of 

                                                                                 For 0 2t    

 

7. i) Write a MATLAB program to find Laplace transform of -          
 

ii) Write a MATLAB program to find Inverse Laplace transform of 
(   )(   )  (   )(   )    

 
8. Find out the poles, zeros and gain of the following transfer functions using MATLAB.  

a)  ( )                           

b)  ( )              
 

9. Determine the transfer function from the given poles, zeros and gain. 

a) Zeros are at S= -1 and -3, poles are at S= 0, -4.5198, -0.7401 2.1522i and gain is k=2. 

 

b) Zero is at S= -5, poles are at S= -1, -0.3542        and gain is at k=2 

 

10. Form the transfer functions  

a)  ( )   (   )(   ) (   )(   ) 
b)  ( )  (   )  (   )  

 

11. Find the overall transfer function. 

1. Connecting   ( )   (       ) (   )(   )        ( )  (   )(    )(   )(   )(    ) in series. 

b) Connecting   ( )   (   )(   )(    )(   )(   )        ( )  (   )(   )  (   )(   ) in 

parallel. 

 

12. Find the closed loop transfer function of   ( )   (   )  (   ) 
- With unity –ve feedback 

- With unity +ve feedback 
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- With the negative feedback having transfer function  ( )   (   ) 
 

 

13. Find overall transfer function by block diagram reduction technique 

 

14. For the given system compare the step response specifications for open loop and closed loop.  ( )  (    )(       ) 
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ASSIGNMENT - 2 

Running Simulink simulation 
 

SIMULINK (SIMUlation LINK) is an extension of MATLAB for modeling, simulating, and 

analyzing dynamic, linear/nonlinear, complex control systems. Graphical User Interface (GUI) 

and visual representation of simulation process by simulation block diagrams are two key features 

which make SIMULINK one of the most successful software packages, particularly suitable for 

control system design and analysis. 

Simulation block diagrams are nothing but the same block diagrams we are using to describe 

control system structures and signal flow graphs. SIMULINK offers a large variety of ready-to-

use building blocks to build the mathematical models and system structures in terms of block 

diagrams. Block parameters should be supplied by the user. Once the system structure is defined, 

some additional simulation parameters must also be set to govern how the numerical computation 

will be carried out and how the output data will be displayed. 

To start SIMULINK, enter simulink command at the MATLAB prompt. Alternatively one can 

also click on SIMULINK icon .  

 

1. Expand the Continuous, Discontinuities, Discrete, and Math Operations sub nodes. 

Study the purpose of various blocks in these sub nodes in description box.  

 

2. Simulate the following equation using SIMULINK blocks  ( )      (     ) 
ω is 10 rad/sec 

 

3. Consider the mass-spring-dashpot where the spring 

and the dashpot are connected in parallel to the 

mass.  

The mathematical model for this system is 

described by    ( )    ̈    ̇     

 

Use SIMULINK to simulate the response of this system to unit step input. 
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HOME WORK: 

 
1.Proof all the experimental results with theoretical calculations.  

 

2. Write a MATLAB program to find the roots of the polynomial 

9s
4
 + s

3
 +5s

2
 +2s+ 11 = 0 

3. Find the general solution of the following differential equation. 

 
2

2
2 0

d y dy
y

dt dt
      

4. Consider the two matrices   [          ]           [           ] 
Write a MATLAB program to determine 

 AB 

 B
T
 

 A
-1

 

5. Write a MATLAB program to generate the plot of                        
6. i) Write a MATLAB program to find Laplace transform of the following          

 

ii) Write a MATLAB program to find Inverse Laplace transform of the following 

 (    )(       )    
7. Find the overall transfer function. 

a. Connecting   ( )   (   )(   ) (   )(   )        ( )  (   )(   )  (   )(   )  in series. 

b.Connecting   ( )  (   )  (   )        ( )   (   )  (   ) in parallel. 

 

8. Find overall transfer function by block diagram reduction technique 
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EXPERIMENT NO.  02  

 

DETERMINATION OF STEP RESPONSE FOR FIRST ORDER & SECOND 

ORDER SYSTEM. WITH UNITY FEEDBACK ON CRO 

&CALCULATIONS OF CONTROL SYSTEM LIKE TIME CONSTANT , % 

PEAK OVERSHOOT, SETTLING TIME ETC., FROM THE RESPONSE. 

SPECIFICATIONS                                                                                                        

 
Objective:  

Determination of step response of 1
st
 & 2

nd
 order system and calculation of control system 

specification 

 

EQUIPMENT DESCRIPTION 

 

The present set up has been designed to provide a convenient means of studying the transient 

response of linear systems. Block diagram approach has been employed as a standard technique, 

with Fig. 1 depicting the features available to in the set up. 

 

A dynamic system of the desired configuration may be constructed by a suitable interconnection of 

the basic blocks available. Following type of blocks have been included in the system. 

 Error detector-cum Gain 

 Integrator 

 Time constant 

 Disturbance adder 

 Uncommitted Amplifier (to invert the feedback signal for getting negative feedback. 

 

The set up has an internal + 12V IC regulated Power supply. 

 

With the help of the above sub-systems a very large variety of simulated systems can be 

constructed. Besides SISO systems this would include MIMO systems as well. 

 

A good quality dual trace oscilloscope is the only external equipment required for the 

experiments. 
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FIRST ORDER SYSTEM: 

 

 These are characterized by one pole and/or a zero. A pure integrator and a single time     constant, 

having transfer function of the form  K/s and K/(sT +1), are the two commonly studied 

representatives of this class of systems. Many thermal systems and electrical systems with RC/L-

R element are the examples of first order systems. 

Unit step response of the systems are computed as follows and are shown in fig.2(a)  

)(

)(

sR

sC
=G(s)= 

s

K
 then for R(s)=

s

1
                                                                        

C(s)= 
2

S

K
 and c(t)=Kt                          (1) 

Again if  ( )   (    ) then with R(s)= 
s

1
 

C(s)=  1sTs

K
,  and c(t)=  Tt

eK
/1                                                  (2) 

Time constant of the system is defined from eq.(2) as t=T which gives 

c(t)=  11  eK =.632K 
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This is an important characteristics of the system which is also defined in terms of the slope of the 

response curve at t=0. 

For a proper viewing on a CRO, the step input needs to be replaced by a square wave of 

sufficiently low frequency (to allow c(t) in eq.(2) to reach up to  99% of its final value).This is 

shown in the figure bellow. A triangular  wave output results since a pure integration block does 

not saturate .it may further be seen that if the square was is of frequency f and peak to peak input 

amplitude is 1v ,the peak to peak amplitude of the triangular wave at the output of the pure 

integrator is given as K/4f. 

SECOND ORDER SYSTEM: 

These systems are characterised by two poles and upto two zeros. For the purpose of transient 

response studies, zeros are usually not considered primarily because of simplicity in calculations 

and also because the zeros do not affect the internal modes of the systems. A great deal of 

analytical results regarding second order systems are available in the textbooks.This forms the 

basis of studying higher order systems many of which cn be approximated to second order. 

A second order system is represented in the standar form as— 

   
22

2

2
)(

nn

n

ss
SG





   ,  

Where δ is called the damping ratio and 𝜔n the undamped natural frequency. Depending upon the 

value of δ, the poles of the system may be real, repeated or complex conjugate which is reflected 
in the nature of its step response. Results obtained for various cases are: 
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 (a) Uderdamped case(  0<δ<1):  

 ( )          √(       (𝜔        √(   )  ) 

Where 𝜔  𝜔 √(   )  is termed the damped natural frequency.  

 (b) Critically dampedcase (δ=1):   ( )         (     ) 
(c) Over damped case (δ>1):  

 ( )    𝜔  √(    ) (               ) 

Where    (  √(    )𝜔   ) and    (  √(    )𝜔   ) 
CLOSED LOOP SYSTEM: 

Close loop or feedback systems involve a measurement of the output of the system And 

generation of control signals which are based on decision making under the influence of a 

command or reference and the measured value of output such systems are of great interest to 

control engineers due to features like automatic correction, disturbance rejection immunity to 

noise and parameter variation etc. A study of the performance of closed loop system is the basic 

objective of this experiment. The closed loop transfer function for different open loop functions 

are shown below: 

(i) For  ( )      ( ) ( )             
Which gives a step response similar to equation (2) with time constant describing as K increases. 
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(ii) For  ( )         ( ) ( )            (   )        

Which has a step response similar in nature as obtained above. 

(iii) For  ( )    (    )   ( ) ( )                     
Which gives response similar to eq (3), (4), (5) depending upon the value of K. 

 

 
Thus the response of a closed loop system can be altered by varying the open loop 

gain K and as a consequence it should be possible to choose K to obtain a suitable 

performance. This leads to the concept of performance characteristics as defined on 

the step response of an underdamped second order system in above figure.  

(i) Delay time(td): it is defined as the time needed for the response to reach 50% of the 

final value 
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(ii)  Rise time(tr): it is the time taken for the response to reach 100% of the final value 

for the first time.         , where        √(    )  

(iii)  Peak time(tp): it the time taken for the response to reach the first peak of the 

overshoot.     𝜔 √(    ) 
(iv) Maximum overshoot (Mp): is straight way difference between the magnitude of the 

highest peak of time response and magnitude of its steady state. Maximum overshoot 

is expressed in term of percentage of steady-state value of the response. As the first 

peak of response is normally maximum in magnitude, maximum overshoot is simply 

normalized difference between first peak and steady-state value of a response. 

    (  )   ( ) ( )           √          

Its value indicates the relative stability of the system. 

(v)  Settling time(ts): is the required by the system response to reach and stay within a 

prescribed tolerance band, which is usually taken as +_ 2% or +_5%. An approximate 

calculation base on the envelops of the response for a low damping ratio system 

yields, ts( 5% tolerance band)=3/ 𝜔  

           ts( 2% tolerance band)=4/ 𝜔  

(vi) Steady state errors(e ss ):  for unity feedback system, ess is defined as           ( ( )   ( )) 
A simpler way to calculate steady state error without actually computing the time response is 

available in the complex frequency domain. Application of final value theorem of Laplace 

Transform to unity feedback system gives 

            ( )          ( )   ( ) 
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STEP RESPONSE – FIRST ORDER SYSTEM 

 

 Two forms of first order closed loop system, as shown in bellow figure are possible. Make 

proper connections for the configuration chosen. 

 

 Apply a 1 volt p-p square wave input and trace the output waveform on a tracing paper for K 

= 0.5, 1.0, 1.5 …….. Calculate the time constant in each case and compare with theoretical 

results. 

 

 If the open loop transfer function in the chosen configuration was of type-1, the steady state 

error above would be zero for a step input. 

 

 Tabulate the result in the following table. 
 

K Time Constant Steady State Error 

 Experimental Theoretical Experimental Theoretical 

     

     

 

 
 

STEP RESPONSE – SECOND ORDER SYSTEM 

 

 Form a suitable second order system configuration as shown in the figure below. 
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 Apply a 1 volt p-p square wave input and trace the output waveform on a tracing paper for 

different values of K. Obtain peak percent overshoot, settling time, rise time and steady state 

errors from the tracing and calculate ζ and ωn. compare with theoretical results.  

 Tabulate the result in the following table 

 

 If the open loop transfer function in the chosen configuration was of type-1, the steady state 

error above would be zero for a step input. 

 

 Tabulate the results in the following table. 

 

K Mp tr tP ts 
ζ ωn 

Expt. Theo Expt. Theo 

         

         

         

  

LIMITATIONS OF THE SYSTEM 

 

The accuracy of the results in an experimental measurement is always limited. Most 

measurements are done using a CRO which may not be better than + 5% 

 

   QUESTIONS 

 

1. Give an example of 1
st
 order & 2

nd
 order system. 

2. Write down the merits & demerits of a closed loop system. 

3. Develop the circuit configurations which simulate the ‘Integrator’. 
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EXPERIMENT NO.   03  

 

SIMULATION OF STEP RESPONSE & IMPULSE RESPONSE FOR TYPE-0 , TYPE-1 & 

TYPE–2 SYSTEM WITH UNITY FEEDBACK USING MATLAB & PSPICE. 

 

Objectives:  

 Developing MATLAB Program to find the step & impulse response of a system.  

 Building simple Simulink simulations to find step & impulse response of a closed loop 

system.  

 Transient analysis using PSPICE 

 

To determine the response of a system using MATLAB first the system is to be modeled to get 

the transfer function. The transfer function is to be expressed as a ratio of two polynomials, 

numerator polynomial & denominator polynomial. 

Two MATLAB-vectors, one containing the coefficients of the numerator polynomial (denoted by 

“num”) taken in descending orders - and one for the denominator polynomial (denoted by “den”) 
of the transfer function are created. 

Once num & den are known, MATLAB command  

step(num,den)  or step(num,den,t) 

Will generate plots of the unit step responses of the given system. The user specified time is given 

by ‘t’ in the step command. 

The unit impulse response of a system can be obtained using MATLAB command 

 impulse(num,den,t) 

To determine the response to an arbitrary input, the command lsim may be used. 

lsim(num,den,r,t), r is the input time function. 

Another way to find the step & impulse response using MATLAB is to use LTI Viewer. It is a 

graphical user interface for viewing and manipulating response plots of LTI system. 

The MATLAB command ltiview(‘step’,sys) will open a window displaying the step response of 

the LTI model sys. 
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ASSIGNMENT  

1. Open MATLAB command window. Observe the commands step, ramp, lsim, ltiview 

 

2. Form a type-0, 1
st
 order system with unity feedback. Find the step & impulse response of the 

system. 

 

3. Form a type-0, 2
nd

 order system with unity feedback. Find the step & impulse response of 

the system. 

 

4. Form a type-1, 2
nd

 order system with unity feedback. Find the step & impulse response of 

the system. 

 

5. Form a type-2, 3
rd

 order system with unity feedback. Find the step & impulse response of 

the system. 

 

6. Use LTI Viewer to find the step response of the system 
                  . From the response 

determine the step response specifications.  

 

7. Use lsim command to find the ramp response of the system 
                  

 

8. Use SIMULINK to compare the response obtained from the unit step input for the systems 

considered in question 3 and 4. 

 

HOMEWORK: 

 
1. Form a type-0, 3

rd
 order system with feedback                 . Find the step and impulse 

response of the system. 

2. Use LTI Viewer to find the step response of the system 
                        . From the response 

determine the step response specifications.  

3. Use SIMULINK to compare the response obtained from the impulse response for the system 

considered in question 1 and a type-1, 3
rd

 order system with unity feedback. 
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EXPERIMENT NO. 04  

 

DETERMINATION OF ROOT LOCUS, BODE- PLOT, NYQUIST PLOT USING 

MATLAB CONTROL SYSTEM TOOLBOX FOR 2ND ORDER SYSTEM & 

DETERMINATION OF DIFFERERNT CONTROL SYSTEM SPECIFICATIONS FROM 

THE PLOT. 

 

Objectives:  

 Developing MATLAB Program to find the Root locus, Bode plot, Nyquist plot of open 

loop transfer function.  

 Determining the closed loop poles from the root locus. 

 To determine Frequency domain specifications from the Bode plot.  

Consider open loop transfer function 
num

sys
den

   where numerator polynomial is denoted by 

“num” & for the denominator polynomial it is denoted by “den”. 

STABILITY USING ROUTH HURWITZ 

routh(poly) makes a routh array and checks the stability of the system by finding if there are any 

roots on right half of the s-plane. It also displays the routh array band the reports about the 

stability of the system. 

PLOTTING ROOT LOCI 

rlocus(sys) computes and plots the root locus of the single-input, single-output LTI model dented 

by open loop transfer function ‘sys’ . 

rlocus(sys,k) uses a user-specified vector K of gain values. 

sgrid(z,wn) plots the grid lines for the given values of damping ratio z and natural frequency wn 

in row vector. If it is desired to omit either the constant z lines or constant wn circles, empty 

brackets [ ] can be used in the corresponding arguments of sgrid command. For example, 

sgrid(0.6, [ ] ) will draw a line for damping ratio z=0.6 only and will not draw any circle. 

rlocfind  Find root locus gains for a given set of roots. 

[k,poles] = rlocfind(sys)  is used for interactive gain selection from the root locus plot of the SISO 

system SYS  generated by rlocus.  rlocfind puts up a crosshair cursor in the graphics window 

which is used to select a pole location on an existing root locus.  The root locus gain associated 

with this point is returned in K and all the system poles for this gain are returned in POLES. 

PLOTTING BODE PLOT 

bode(sys) draws the Bode plot of the LTI model sys (created with either TF, ZPK, SS, or FRD).  

The frequency range and number of points are chosen automatically. 

To specify the frequency range, use the command 

w=logspace(d1,d2,n) 
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bode(sys,w) 

Here MATLAB generates n points logarithmically equally spaced between decades 10
d1

 to 10
d2

. 

[gm,pm,wcg,wcp] = margin(sys) computes the gain margin Gm, the phase margin Pm, and the 

associated frequencies Wcg and Wcp, for the SISO open-loop model SYS. 

DRAWING NYQUIST PLOT 

The command nyquist(sys) draws the Nyquist  plot of the LTI model sys (created with either TF, 

ZPK, SS, or FRD).   

The command  nyquist(sys,w) calculates the frequency response at the frequency point 𝜔 in 

rad/sec. 

ASSIGNMENT  

1. Open MATLAB command window. Observe the commands  rlocus, bode, nyquist, margin. 

 

2. Plot root locus and examine the stability of the following system using MATLAB:  ( ) ( )                  

If the gain K is varied over a range of: 

a) K=2,4,6,8 

b) K=2,4,6,8,10 

 

3. Find the values of K for damping ratios mentioned in the following transfer functions using 

MATLAB: 

a) 
  (   )(   ) for ξ=0.5 

b) 
 (    ) (   )(   ) for ξ=0.4 

 

4. Obtain the Bode diagrams for the following transfer functions in the specified frequency 

range using MATLAB:  ( )  (   ) (       ), 𝜔=0.01 to 1000 rad/sec 

 

5. Obtain the Bode plot of the system 
               . using MATLAB. From the plot determine 

gain margin, phase margin, gain cross-over frequency & phase cross-over frequency.  

 

6. Consider unity feedback system with the following open-loop transfer function   ( )         . Determine the Nyquist plot using MATLAB and examine the stability of the closed 

loop system. 

 

 

7. Sketch a Nyquist plot for a system with the open loop transfer function (for K=10);  ( )   (      )(   )(    )(   )  
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HOMEWORK: 

 

1. Proof all the experimental results with theoretical calculations.  

 

2. Consider the characteristic equations of a system are given by: 

 

a)                       

b)                       

Check the stability with Routh-Hurwitz criterion using MATLAB. 

3. Consider a unity feedback system with the following transfer function:  ( )    (       ) 
Plot the root locus and draw grid line for damping ratio, ξ=0.5. Determine closed loop poles 

that have the damping ratio ξ=0.5 and find the gain value, K at this point. 
4. Obtain the gain and phase margins, phase cross over and phase cross over frequencies of the 

following transfer function:  ( )                  
5. Draw a Nyquist plot using MATLAB for the following transfer function:      ( )          

and comment on stability. 

 



CONTROL  SYSTEM  LABORATORY PC EE 593 

 

 
SILIGURI INSTITUTE OF TECHNOLOGY 

DEPARTMENT OF ELECTRICAL ENGINEERING 

EXPERIMENT NO.  05  

 

DETERMINATION OF PI, PD,PID CONTROLLER ACTION OF FIRST ORDER 

SIMULATED PROCESS. 

 

Objectives:  

 To determine the effect of controller on a system.  

  

 

To achieve the desired control action a controller is used to modify the error signal to be finally 

fed to the plant. 

 

Controller can be on-off type or continuous type. 

There are three basic modes of continuous control actions. 

Proportional (P) 

A proportional controller attempts to perform better than the On-off type by producing a control 

action that is proportional to the error. i.e. controller output = Kpe, with Kp being the proportional 

gain. 

Derivative (D) 

A derivative controller produces a control action that is proportional to the rate of change of the 

error. i.e. controller output = Kd(de/dt), with Kd being the derivative gain. 

Integral (I) 

A integral controller produces a control action that is proportional to the integral of the error. i.e. 

controller output =   ∫     , with Ki being the integral gain. 

The transfer function of the PID controller looks like the following:  

                        

The Characteristics of P, I, and D controllers are as tabulated  
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CLOSE LOOP RESPONSE RISE TIME OVERSHOOT SETTLING TIME S-S ERROR 

Kp Decrease Increase Small Change Decrease 

Ki Decrease Increase Increase Eliminate 

Kd Small Change Decrease Decrease Small Change 

 

Tips for Designing a PID Controller 

1. Obtain an open-loop response and determine what needs to be improved. 

2. Add a proportional control to improve the rise time  

3. Add a derivative control to improve the overshoot  

4. Add an integral control to eliminate the steady-state error  

5. Adjust each of Kp, Ki, and Kd until you obtain a desired overall response.   

ASSIGNMENT  

1. Consider unity feedback system with the following open-loop transfer function                    ( )    (      ) .Determine closed loop transfer function of the system. Also determine 

the closed loop transfer function of the system with PD controller in the forward path with 

KP=1 and KD=0.2. 

           Compare the step responses for the systems – 

a. Without PD controller 

b. With PD controller 

 

 

2. Consider a unity feedback system with the following open-loop transfer function                ( )   (   ) . 
Design a PI controller satisfying the following requirements : 

ζ = 1 and ωn = 5 rad/sec 
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EXPERIMENT NO.   06  

 

DETERMINATION OF APPROXIMATE TRANSFER FUNCTION 

EXPERIMENTALLY FROM BODE PLOT. 

 
Objectives:  

 To set up a 1
st
 order system using RC circuit. 

 Determine the frequency response to develop Bode Plot Experimentally 

 Determine the Transfer function from the Bode plot.  

A graphical approach is usually the easiest way to analyze and design feedback systems. Bode's 

method consists of plotting two curves, the log of gain, and phase, as functions of the log of 

frequency. 

Usually the gain in decibels, abbreviated dB, and the phase are plotted linearly along the y axis on 

graph paper that has several cycles of a log scale on the x axis. Each cycle represents a factor of 

ten in frequency. This special paper is known as semilog graph paper 

In this experiment, we will measure theMagnitude and Phase response of a RC-electrical circuit to 

a sinusoid at various frequencies. 

 

The RC circuit is as shown in the figure. 

By viewing the circuit as a voltage divider, the voltage 

across the capacitor is: 

 

The transfer function for the circuit  is 

 
 

The bode plot for the system is given by as 

shown in the plot. 

 

The break frequency or the corner frequency 

will be at 

 

1
C

w
RC

  

 

 

 

 

 

http://upload.wikimedia.org/wikipedia/commons/e/e0/RC_Series_Filter_(with_V&I_Labels).svg
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Procedure 
 

 Set up the RC circuit using C = 0.1μF and R = 1Kω. 
 A signal generator is used to generate variable frequency sine wave. 

 Set the amplitude of the signal generator to 5 volt. 

 The oscilloscope is connected to measure vin and vout. The peak-to-peak magnitudes of vin 

and vout  are measured. The ratio of these magnitudes is equal to the transfer function 

magnitude. 

 To measure the phase using an oscilloscope, the oscilloscope is triggered by vin(t), and the 

time per division is adjusted so that one period of vin nearly fills the entire width of the 

screen (from the left edge of the graticule to the right edge). The trigger and horizontal 

position controls are adjusted so that a positive-going zero crossing of vin(t) occurs at the 

center of the screen. The positive-going zero crossing of vout(t) is then found, and the 

horizontal distance between the positive-going zero crossings of vout and vin is measured. 

The phase shift between vout and vin is then given by 

   (  )    ̂      ̂   

                                           (    ) (                          )(               )  

 Change the frequency of the signal generator and tabulate the data in Table – I. 

 Draw the Bode plot using the experimental results. 

 Determine the slope of the Bode plot (dB per decade) in the high or low frequency 

 limit . Make a plot of your data together with a theoretical function drawn through (or 

near?) the data. 

 Determine the frequency at which low frequency asymptote meats with the high frequency 

asymptote. This gives the corner frequency. 

 Compare your measured value to the calculated value. 

 

Table - I 

 

 

Frequency(f) 

 IN
V  OUTV  

OUT

IN

V
M

V
  

1020Log M  t    
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EXPERIMENT NO.   07  

 

EVALUATION OF STEADY STATE ERROR, SETTING TIME, 

PERCENTAGE PEAK OVERSHOOT, GAIN MARGIN, PHASE MARGIN 

WITH ADDITION OF LEAD COMPENSATOR & BY COMPENSATOR IN 

FORWARD PATH TRANSFER FUNCTION FOR UNITY FEED BACK 

CONTROL SYSTEM USING PSPICE OR OTHERWISE. 

 
Objectives:  

 To determine the effect of adding a Lead compensator in forward path transfer function.  

 To compare the unit step response parameter of an uncompensated & compensated 

system.  

Software used – MATLAB 

The most important thing for the design of the controller to control one process or a system is to 

select the controller that fits to the process. Selecting the appropriate controller that is suitable for 

the process is no less than completing 90% of the design work.  

Lead Compensator or Lead 

Controller is the same 

terminology and let's call it 

GC(s). This consists of one 

pole point and one zero 

point and can be expressed as  

 

( )
C

s a
G s

s b





 

 

Goal of compensation is to improve system dynamics in transient and steady-state responses 

 

Lead compensation: typically used when substantial improvement in damping is required. The 

effect of lead compensator is similar to that of adding a PD controller. 

 

Lag compensation: to improve steady-state response characteristics without changing transient 

response characteristics significantly. The effect of Lag compensator is similar to that of adding a 

PI controller 

 

Lead+Lag compensation : when improvements in both phase margin and low- frequency gain 

are needed 
 

 

 

 

 

The lead compensator helps speed the response of the system by moving the closed-loop poles to 

the left. Without the lead compensator, the root locus has a vertical asymptote halfway between 

the integrator (s=0) and the open loop pole (as shown below). 
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The lead compensator can be realized using the following circuit. 

 

 
The transfer function is given by 

 
 

 

  ( )  ( )                                                
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ASSIGNMENT - 1 

Open-loop transfer function of a unity feedback system is given by  

 
Using MATLAB plot the unit step response of the uncompensated & compensated system using 

lead compensator  given by  

 

0.088
( )

0.022
C

s
G s

s





 

 

Compare the performance characteristics. 

 

 

ASSIGNMENT - 2 

Consider a unity feedback system 

 

.  

A lead compensator is introduced into the forward path where, 

 

0.3
( )

0.03
LEAD

s
W s

s





 

 

Determine the bode plot of the compensated system.  

Determine the peak magnitude & the bandwidth of the closed loop frequency response. 
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EXPERIMENT NO.    08  

 
STUDY OF A PRACTICAL POSITION CONTROL SYSTEM & 
DETERMINATION OF CONTROL SYSTEM SPECIFICATIONS FOR 
VARIATION OF SYSTEM PARAMETERS. 
 
Objectives:  

 To study & observe the performance characteristics of a dc angular position 
control system.  

  

 
The schematic diagram in Fig. 1 shows the various built-in subsystems of the set up. 
The position control is achieved through a good quality permanent magnet dc gear motor 
having the specifications : 
 

 Operating voltage – 12 V dc 

 Full load current – 1.2 amp 

 Rated speed – 50 rpm 

 Torque (basic) – 750 gm-cm (approx) 
Angular position of the motor shaft is sensed by a special 3600 potentiometer attached to 
it. A calibrated disk mounted on the potentiometer indicates its angular position in 
degrees. 
 
BACKGROUND 
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CLOSED LOOP STUDY 

 
The steps are as follows. 
 

 Ensure that the step command is switched off 

 Set KD = 0. 

 Set KA = 2. 

 Calculate 0 0, , ,R RV V  in Table – I. 

 Calculate 0,R    

 Repeat for KA = 4.6,8,10 

 Now set KA = 2 and choose various values of  KD = 0.1, 0.3, 0.5, 0.7 and repeat 
the above observations in Table - II 
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TABLE - I 
 
K 

R  
R  

0  
0  

RV  
0V  

       

       
       

 
 
TABLE - II 
 
KD R  

R  0  0  
RV  0V  

       
       

 
 
 
Step response 
 
The steps are as follows 
 

 Set KD = 0. 

 Adjust reference potentiometer to get VR = 0. 

 Set KA = 5. 

 Connect the CRO, calibrate the time scale and switch to CAPTURE mode. 

 Apply step input 

 Trace the waveform from the CRO. 

 Compute  , , , ,
P p r ss

M t t e . 

 Repeat for KA = 8,10 

 Tabulate the results in Table - III 
 
 
 
TABLE - III 
 
KA PM  pt  (ms) 

rt  (ms)   
ss

e  (volt) n
w  

       
       

 
 
 
CALCULATIONS 
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Objectives: 

a. Introduction to SISOTOOLS. 
b. Design of a Compensator for a given system and its step response. 

 

  EXPERIMENT NO. 09  

DESIGN OF LEAD AND LAG COMPENSATION USING CACSAD TOOLS (Plant transfer 
function will be provided. Step response is to be obtained. (PSPICE, MATLAB, SciLab may 
be used). 

 

A lead–lag compensator is a component in a control system that improves an undesirable 
frequency response in a feedback control system. 
We can realize lead and lag compensation by introducing a cascade compensator of the form 

 

 

For Lag Compensator 

 

 

For Lead Compensator 

 
Introduction to Matlab ‘sisotool’ 

 
 

 

 
A. Getting Started 

Generic Unity Feedback Control System 

 Enter the transfer function P(s) for the plant, in your workspace (i.e., from the 
Matlab command prompt).

 Type ‘sisotool’ at the command prompt.
 Click Close when the help window comes up.

 Click on View →Open Loop Bode to turn off the bode plot. (Whatever is 

checked in this list will be displayed in the window.)
B. Loading the Transfer Function 

 1. Click on File → Import .
 A window on the left will show you the transfer functions in your workspace, 

while the window on the right will let you choose the control system 
configuration.
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 We will usually be assigning P(s) to block ‘G’ (the plant). Double-click the space 
next to ‘G’ and type your transfer function name and hit Enter. You must hit 
enter or nothing will happen.

 Once you hit enter, you should be able to click the OK button at the bottom of 
the window. Then the window will close.

 After you enter the transfer function, the root locus will be displayed. Double 
check to make sure that the open-loop poles and zeros of your plant are in the 
correct locations.

C. Generating the Step Response 

 Click on Analysis → Response to Step Command .
 You will probably two curves on your step response plot. To fix this click on 

Analysis → Other Loop Responses… Make sure only r to y is checked, and then  

click OK.
 You can now click on the pink boxes on the root locus (the current closed-loop 

poles for the given gain) and move them along the root locus. Essentially, you are  
exploring different controller gain values by doing this. Note how the step 
response changes as you move the closed-loop pole locations.

 The values of the closed-loop poles will appear at the bottom of the root locus 
window as you click and hold the mouse on the pink boxes representing them. 
This only gives you the value of the closed-loop pole you are clicking on. If you 
need the other closed-loop pole locations, you will have to click on them on each 
of the other branches.

D. Entering the Compensator (Controller) 

 Click Compensators →Edit →C. Click on Add Lead or Add Lag to enter 

Compensator. You will be able to make changes to these values later. After you are done, 

click OK to exit this window.
  Look at the form of C(s) to be sure it is correct. Then look at the root locus window and 

see how it changed once the compensator was added.
 You can again see how the step response changes with the compensator by clicking on 

the closed‐loop poles (the pink squares) and dragging them along the root locus.
 You can also change the location of the poles/zeros of the compensator by clicking on 

them and dragging them. Be careful not to inadvertently change the poles and zeros of 

the plant.
E. Adding Design Constraints 

  Click Edit → Root Locus → Design Constraints then either New to add new 

constraints or Edit to edit existing constraints.
 At this point you can choose from settling time, percent overshoot, damping ratio, and 

natural frequency constraints.
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Assignment - 1 

The feedback control system has 

H(s)=1 and 

G(s) 
K 

 

 

s(s  2)(s  3) 
, K is the last two digits of your roll number 

Using sisotool determine 

a. The range of controller gain for the system to be stable 

b. Value of controller gain for the complex dominant-poles damping ratio of 
0.6. for this value of gain obtain the frequency response GM and PM. Also 
obtain step response and the time-domain specifications. 

 
Assignment - 2 

 

For the above system design a lead-lag compensator for the following unit step response 
specifications. 

a. Dominant poles damping ratio =0.707 

b. Settling time less than 8 seconds. 

c. Peak response less than 1.2 
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EX PERIMENT NO.   

 

 

Objectives:  
a. Familliarization with the MATLAB commands for state variable analysis. 
 Obtaining transfer function from a given SV model using MATLAB programming.  
b. Obtaining SV model from a given transfer function using MATLAB programming. 

 

 

 
ASSIGNMENT - 1 
 
1. Open MATLAB command window. Observe the commands  

ss2tf, tf2ss, ss2zp, eig, inv, ctrbf, obsv, lyap, canon, size, initial, rank, ,dsolve,plot 
 

2. Write a matlab program to input the following two matrices 
 

1 2
A

3 4

 
 
           

5 6
B

7 8

 
 
    

Also determine the followings 
i) P=A+B       ii)       Q=transpose of B       iii)      R=inverse of A        
iv)   determinant of  B  

 
Check the results with theoretical calculations. 
 
3. Find out the Eigen Values & Eigen Vectors of the following matrices. 

 

a) 
1 2

 
3 4

A
 

  
 

 

 

b)       

4 1 5

2 1 3  

6 7 9

A

 
   
  

 

verify the result with theoretical calculations. 

 
 
 

.

Determination of Transfer Function of a given system from State Variable model and
vice versa.

10
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ASSIGNMENT - 2 
 
1. Given the dynamic equation  

3 2

3 2
6 11 6

d y d y dy
y u

dt dt dt
    ,  t>0 

 

Using MATLAB program, find 
 

a) x(t) when all the initial conditions are zero 
b) x(t) when x(0) = 1 & x’(0) = 2    (Hint : Use ‘dsolve’) 

 
 
2. Obtain the state-space representation of the following system using MATLAB 

 

a) 
3 2

( ) 12 7

( ) 5 32 7

C s s

R s s s s




  
 

b) 

4 3 2

5 4 3 2

( ) 3 12 7 8

( ) 9 5 7 7

C s s s s s

R s s s s s

   


   
         

 
Draw the State Diagram of the above systems. 

 

3. Find the Transfer Function of the following systems using MATLAB program 
 

a) 

 

0 1 0
( ) ( ) ( )

-2 -3 1

( ) 1 0 ( )

x t x t u t

y t x t

   
    
      




 

 

Check the result with theoretical calculation. 
 
 

b) 

 

0 3 7 0 0

0 0 1 0 5
( ) ( ) ( )

0 0 0 1 7

5 6 9 5 2

( ) 1 3 6 5 ( )

x t x t u t

y t x t

   
   
   
       
   
       




 

 

4. Find the Unit Step response  of the following systems using MATLAB program  
 

a) 

 

0 1 0
( ) ( ) ( )

-2 -3 1

( ) 1 0 ( )

x t x t u t

y t x t

   
    
      




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EX PERIMENT NO.   

 

 

Objectives:  
a. Familiarization with the MATLAB commands for state variable analysis. 
b. Obtaining step response and initial condition response for a SISO system given in 

SV form using MATLAB programming  
c. Obtaining step response and initial condition response for a Two input system 

given in SV form using MATLAB programming . 
 

ASSIGNMENT – 1 
 
1. Open MATLAB command window. Observe the commands  

jordan, fliplr, flipud, ctrbf, obsv, initial, kalman, acker, place. 

 
2. Write a MATLAB program to determine the STM for the given A matrix as 

 

a. 
0 1

2 3
A

     
 

 
Verify the result by theoretical calculation. 
 

b. 

 
 
   
    

0 1 0

0 0 1

6 11 5

A  

 
 
ASSIGNMENT – 2 

 

1. Find the Unit Step response  of the following system using MATLAB program  

 

1 1

2 2

3 3

1

2

3

5 17 5 1

1 0 0 0

0 1 0 0

0 25 5

x x

x x u

x x

x

y x

x

         
       
               
       
       

 
 
   
 
 





 

          Also find out the response for the initial conditions 
 

     

1

2

3

1

2

0

x

x

x

   
   
      
   
   

 and  

1

2

3

0

5

7

x

x

x

   
   
      
   
   
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2. Solve the problem stated in 1. Using SIMULINK  
 
 

 
 

1 1 1

2 2 2

1 1

2 2

1 1 1 1

7 0 1 0

1 0

0 1

x x u

x x u

y x

y x

                                  
    
            




 

      

     Also find out the response for the initial conditions 
 

     1

2

1

5

x

x

   
        

 

     Verify the result with theoretical calculation. 
 

ASSIGNMENT – 3 
 

1. Test the Controllability and Observability of the following systems 
 

 a) 

 

0.5 0 0
( ) ( ) ( )

-0 2 1

( ) 0 1 ( )

x t x t u t

y t x t

             



 

b) 

 

1 0 0 1

( ) 0 2 0 ( ) 1 ( )

0 0 3 0

( ) 1 0 2 ( )

x t x t u t

y t x t

   
   
        
         




 

2. Write a MATLAB program to determine the state feedback gain matrix so that closed 
loop poles are located at -2, -5 & -6 
 

          c)    

 

0 1 0 0

( ) 0 0 1 ( ) 0 ( )

0 30 11 1

( ) 1 0 0 ( )

x t x t u t

y t x t

   
   
       
       




 

 

Verify obtained result with theoretical calculations 
 

HINTS : Use ‘place’ or ‘acker’ command 

3. Find theUnit Step response of thefollowingsystemusing MATLAB program
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